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Introduction

This tutorial introduces the concepts of multiaxis machining, beginning with the 
machine architecture and ending with multiaxis toolpath creation. Multiaxis toolpaths 
are basically the familiar contour, pocket, and surface toolpaths in X,Y, and Z, with 
rotational motion added in A, B, and C. The available axes vary based on your partic-
ular machine setup.

The workflow is consistent regardless of the multiaxis toolpath selected. Mastercam’s 
Multiaxis interface follows a uniform structure through the toolpathing process. Select 
the toolpath family, select a toolpath type, progress from top to bottom through the 
tree-style interface, enter parameters on the necessary pages, and generate the tool-
path. Additional tools such as Mastercam Simulator and Machine Simulation allow you 
to review your toolpath before cutting begins on the machine.

By completing this tutorial, you gain a general understanding of the multiaxis process. 
The information contained in these pages gives you the knowledge and confidence to 
work with Mastercam’s multiaxis toolpaths.

Tutorial Goals
 Understand the basic architecture of a multiaxis machine
 Review the controls of a multiaxis toolpath: cut pattern, tool axis control, and 

tool tip control
 Follow the workflow of Mastercam’s Multiaxis toolpath interface
 Create and modify a Multiaxis Curve toolpath
 Create and modify a Multiaxis Drill toolpath

Introduction to Multiaxis Toolpath Requirements
 Mastercam 2017 with Mill or Mastercam Router
 Curve 5-axis / Drill 5-axis add-on (included in the Multiaxis add-on)

Estimated time to complete this tutorial: 1.5 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
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 The tutorials cannot be used with Mastercam Demo/Home Learning Edition 
(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file 
format (mcam), and basic Mastercam functions, such as file conversions and 
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 
We recommend that you complete them in order. 

 Additional files may accompany a tutorial. Unless the tutorial provides specific 
instructions on where to place these files, store them in a folder that can be 
accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.

 All Mastercam tutorials require you to configure Mastercam to work in a 
default metric or English configuration. The tutorial provides instructions for 
loading the appropriate configuration file.
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LESSON 1
1Basic Machine Overview

With a multiaxis machine, instead of a straightforward machine with XYZ axes capabil-
ities, you have a machine that can handle five or more axes of motion. Typically, the 
axes are defined as XYZ/ABC/UVW as shown below.

The axes may be in a different orientation or have different relationships. The point is 
that your machine now has a much greater range of motion than a standard 3-axis 
vertical or horizontal machine.

The added motion of a multiaxis machine enhances the capabilities of your shop, as 
well as expands the variety of parts that you can machine. However, due to the 
enhanced power of the machine, there is no “standard 5-axis machine.” Nearly every 
machine is unique in its axes combination, orientation, travel and rotation limits, and 
controller.

Common terms for multiaxis machines are table/table, head/table, and head/head. 
These terms describe the relationship of the rotary components on the machine. The 
configuration of the rotaries determines the zero location of the machine and how you 
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need to locate the part within Mastercam. The part must be located in Mastercam 
where it will be sitting on the machine. The only exception is for a head/head arrange-
ment.

IMPORTANT: Improper location of your geometry will cause the part to 
be cut incorrectly.

Table/Table Machine
A table/table machine has both rotary axes connected to the table. Typically this is a 
trunnion carrying a rotary table. The machine axes zero position is located at the inter-
section of rotary axes. Your part is located in Mastercam relative to the machine zero 
position. The rotary components are shown in red in the following images.

Table/Table configuration
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Head/Table Machine
A head/table machine has one rotary on the table and the other on the spindle. They 
operate independently of each other. The table could be comprised of a trunnion or 
simply a rotary attached to the table. The machine axis zero is located at the intersec-
tion of the rotary axes. Your part is located in Mastercam relative to the machine zero 
position, as in the table/table configuration. The rotary components are shown in red 
in the following images.

Table/Table machine zero
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Head/Table configuration

Head/Table machine zero
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Head/Head Machine
A head/head machine has both rotary axes connected and attached to the spindle. 
The machine axis zero is typically located on the face of the spindle. The origin is 
shown on the table in the second image as this is where the spindle face lies when all 
axes are set to zero. The rotary components are shown in red in the following images. 

Head/Head configuration

Head/Head machine zero
INTRODUCTION TO MULTIAXIS TOOLPATHS
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These are the basic arrangements of multiaxis machines. Be aware that multiaxis 
machines may be as simple as a single rotary for 4-axis work, or as complex as having 
five axes and a nutating head. No matter how the machine is configured, the inputs for 
a good toolpath follow the same pattern from machine to machine. Continue on to 
Lesson 2 to learn about the necessary controls for creating an efficient multiaxis tool-
path.
INTRODUCTION TO MULTIAXIS TOOLPATHS



LESSON 2
2Multiaxis Toolpath Controls Overview

Three controls separate multiaxis toolpaths from the typical 2- and 3-axis toolpaths: 

 Cut Pattern
 Tool Axis Control
 Tool Tip Control

Effective use of these controls is the deciding factor in your ability to create efficient 
toolpaths for your particular machine. This tutorial starts you on the path to becoming 
a more effective programmer. However, there is no substitute for experience and 
knowing your machine’s capabilities.

Cut Pattern
What do you want the tool to follow? The answer is the cut pattern. Selecting a tool-
path family is the initial phase of establishing the cut pattern. Different toolpath fami-
lies vary the type of geometry allowed for the cut pattern. Geometry selection can 
range from a contour or chain, to a surface edge or edges, and on through single or 
multiple surfaces or solids. Below are two examples of cut pattern selections.

In addition to the geometry selected for the toolpath, cut pattern includes such 
parameters as:

Curve Surface
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 Cutting method: zigzag, one way, spiral 
 Compensation: type and direction
 Stock to leave: drive surfaces, walls
 Stepover: across, along, increment

Subsequent lessons and tutorials cover cut pattern options in more detail.

Tool Axis Control
How do you want the tool axis to behave as it follows the cut pattern? Tool axis 
control answers this question. Multiaxis toolpaths include numerous options on how 
to manipulate the tool axis. The options allow you to control the part of the tool in 
contact with the material, and the amount of tool movement the toolpath generates, 
as well as being able to set the number of axes of output for the posted toolpath. 
Below are two examples of tool axis control.

Toolpath family and toolpath type determine which tool axis controls you can access. 
Some examples of the controls available include: 

 Lines, surface, from point, chain
 Fixed angle to axis, be tilted relative to contact point
 Rotated around axis, from point
 Parallel to line, surface, plane

Surface From point
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Click the Help button in Mastercam to find further details on the available options and 
their function.

Tool Tip Control
What controls the depth of the tool along the tool axis? Tool tip control handles this 
function. Compensation surfaces are included in tool tip control. Applying tool tip 
control is a three step process:

1  Tool positions are generated along the selected cut pattern.

2 Tool axis vectors are created at each position based on the tool axis control 
settings.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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3 Depth along the tool axis is applied based on the tip compensation method.

TIP: Use the method depicted above when you have very complicated, 
or less than perfect, part geometry. The clean core geometry is used to 
generate the cut pattern and tool axis control vectors. Tip control is then 
used to cut the outer surfaces with much cleaner motion.

The three controls described above form the core of all your multiaxis toolpaths. Addi-
tional refinement is added through collision control, linking, tool selection, and more. 
Building confidence with these controls will greatly ease and enhance your ability to 
generate efficient multiaxis toolpaths. Continue on to Lesson 3 to see how these 
controls are an integral part of the multiaxis workflow within Mastercam.
INTRODUCTION TO MULTIAXIS TOOLPATHS



LESSON 3
3Mastercam Interface and Workflow

Mastercam’s Multiaxis toolpath interface follows the familiar tree-style layout. You 
progress through the pages of the tree, make the necessary selections, enter appro-
priate parameters, and generate your toolpath. Viewing the process in simplified terms 
helps to lessen the complexity of creating a multiaxis toolpath.

Begin the toolpath creation process by selecting an appropriate machine definition. 
This applies to all toolpath types in Mastercam. After selecting a machine definition 
that supports multiaxis movement, choose a Multiaxis toolpath. The following image 
shows the starting point for a Curve toolpath.

Multiaxis toolpaths are divided into two toolpath families, Pattern and Application. 
Each toolpath family contains different toolpath types. Selecting the most efficient 
type will come from experience and usage. For now, you focus on the general work-
flow rather than specific applications.
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The tree structure provides the basic roadmap to 
creating a toolpath. While you can select the pages as 
needed, the most efficient route is from top to bottom. 
Click the plus sign before any page to expose additional 
pages for input.

The pages within the tree structure vary with the tool-
path type. The procedure remains the same regardless of 
what the tree looks like. If you can answer the following 
questions, you are well on your way to generating a 
multiaxis toolpath:

 What do I want the tool to follow?
 How do I want my tool axis to behave?
 What controls the depth along the tool axis?

Cut Pattern Page
The controls discussed in the previous lesson are pivotal for multiaxis work. The cut 
pattern page is where you select your drive geometry, set compensation parameters, 
and set various other options. Below is a sample of the cut pattern page for a multiaxis 
Curve toolpath.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Tool Axis Control Page
The Tool Axis Control page defines the tilting motion of the tool axis as it moves along 
the cut pattern. The options available vary by toolpath type, just as the tree structure 
and other pages vary. Tool axis control is what sets multiaxis toolpaths apart from 2- 
and 3-axis toolpaths. The ability to manipulate the tool axis allows for complex and 
powerful control. Below is a sample of the Tool Axis Control page for a multiaxis Curve 
toolpath.

Collision Control Page
Tool tip control does not have its own page like the other two controls. It can be found 
on the Collision Control page. Use the parameters to instruct Mastercam how the tip 
of the tool should be placed in relation to the cut pattern. Below is a sample of the 
Collision Control page for a multiaxis Curve toolpath.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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Complete the remaining pages in the tree if necessary. Additional parameters include 
linking information (how the tool moves when not in contact with material) and 
roughing options. The Additional Settings branch provides pages that generally do not 
need to be touched for multiaxis programming. Review them, and click Help if you 
want to know details about these pages. Continue on to Lesson 4 to begin creating a 
multiaxis Curve toolpath.
INTRODUCTION TO MULTIAXIS TOOLPATHS



LESSON 4
4Multiaxis Curve Toolpath

Experience with design and toolpath creation is assumed at this point of the tutorial. 
Detailed steps on such actions as selecting a machine definition, changing the 
graphics view or construction plane, or making levels visible, are not provided. Please 
review the Introduction to Mastercam tutorial before continuing if you are not familiar 
with these concepts.

Lesson Goals
 Open a part file and assign a machine definition.
 Create a Multiaxis Curve toolpath.
 Backplot the toolpath.

Exercise 1: Getting Started with Toolpath Creation
Assigning a machine definition is the first step in creating a toolpath. Setting the 
graphics view to allow the easiest geometry selection plays a part in visualizing your 
work. This exercise guides you through the initial steps involved with creating a tool-
path.

1 Start Mastercam using your 
preferred method:

 Double-click Mastercam’s 
desktop icon.
Or

 Launch Mastercam from the 
Windows Start menu.

2 Select the default metric configuration file:

a Click the File tab.
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b Choose Configuration from 
Mastercam’s Backstage View to 
open the System Configuration 
dialog box.

c Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d Click OK.
 

3 Open the part file Curve_Toolpath, which was provided with the tutorial.

4 If not already loaded, select the default Mill metric machine definition.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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NOTE: The default machine definition has rotary axes defined that allow 
multiaxis toolpaths. Load the machine definition of your choice as long 
as it supports 5-axis motion.

5 Set your graphics view to Isometric.

6 Activate shading if necessary.

7 Fit the geometry to the screen using [Alt+F1] or the Fit button on the View 
tab.

8 Choose File, Save As, and save the part under a different file name. This 
protects the original tutorial file from being overwritten.

Exercise 2: Create a Multiaxis Curve Toolpath
Creating a toolpath involves selecting the toolpath type, tool, and geometry, as well as 
completing the parameter pages. Completing this process yields a program capable of 
cutting your part on a machine.

1 From the Toolpaths tab, choose Multiaxis, Curve.

2 Click OK if prompted to enter a new 
NC file name.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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3 Select Tool from the tree view pane.

4 Click the Select library tool button. 
The tool library defined in the 
machine definition opens.

5 Click the Filter button, and set the 
filter to show only Endmill2 Sphere 
tools.

6 Select the 8mm ball endmill and click OK.

7 Select Cut Pattern from the tree view pane.

8 Choose 3D Curves from the Curve type drop-down selection.

9 Click the Select points button next to 3D Curves to return to the graphics 
window for curve selection. The Chaining dialog box displays. 
INTRODUCTION TO MULTIAXIS TOOLPATHS
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10 Select the chain on the edge of the part as shown. The start position is not 
important for the purpose of the tutorial. The chain should go in a clockwise 
direction, regardless of the start point.

11 Click OK in the Chaining dialog box to return to the Cut Pattern page.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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12 Set the remaining parameters as shown. 

TIP: The radial offset value for this particular operation should equal the 
tool radius. Use this field in a similar manner as a stock to leave. A value 
equal to the tool radius is equivalent to zero stock to leave. Take advan-
tage of this functionality for trimming operations.

13 Select Tool Axis Control from the tree view pane.

14 Choose To point from the Tool axis control drop-down selection.

15 Click the Select button to return to the graphics window for point selection.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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16 Select the point as indicated.

You return to the Tool Axis Control 
page.

17 Set the remaining parameters as shown.

TIP: Click in a field to see a progressive image on the right side of the 
page. The image depicts what the field controls. Click Help for detailed 
information on each field.

18 Select Collision Control from the tree view pane.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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19 Set Vector depth to -10.0. The value allows the curve operation to trim the 
part with the side of the tool, avoiding the ball portion at the tip.

The images below show how the difference between vector depth values 
affects the toolpath.

20 Select Roughing from the tree view pane.

21 Ensure that Multi Passes has been 
deselected.

Trimming operations using a Curve 
toolpath generally utilize a single 
pass.

Vector depth = 0.0 Vector depth = negative
INTRODUCTION TO MULTIAXIS TOOLPATHS
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22 Click OK to generate the multiaxis curve toolpath on the selected geometry.

23 Save your part file.

Exercise 3: Backplot the Operation
Backplotting an operation allows you to review the tool motion before any cutting 
takes place on the actual machine. Backplot should be the first step in validating your 
toolpath.

1 Click Backplot selected operations 
in the Toolpaths Manager.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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2 In the Backplot dialog box, select the 
Display tool and Display rapid 
moves buttons.

3 Click Options in the Backplot dialog 
box.

4 Deselect the options shown and 
click OK. This prevents your part 
from spinning around and moving 
out of view.

5 Click Play to begin the backplot of your toolpath.

6 Click OK in the Backplot dialog box when you have finished reviewing the tool 
motion.

Exercise 4: Machine Simulation
Machine simulation is the next step in validating your operations. The tool motion is 
shown on your part as it is positioned on your machine. Collisions between various 
machine components and the part are visually apparent, as well as reported in text on 
the screen. The following is a quick run-through of Machine Simulation. For a more 
detailed explanation, review Help, as well as the Machine Simulation tutorial. 
INTRODUCTION TO MULTIAXIS TOOLPATHS
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1 On the Machine tab, click the dialog 
box launcher in the Machine 
Simulation group.

2 Select 6_5AXGEN_VMCHTAC from 
the drop-down list of machines.

The machine selection is saved with 
the part file. Running simulation on 
the same part file will reload the 
selected machine.

3 Click Simulate to begin the machine 
simulation of the selected operation.

4 Use the simulation playback buttons to review the tool motion contained in 
your operations. (If you do not see the part, click the Workpiece button, 
which is located in the Simulation tab’s Visibility drop-down.).)

5 Exit machine simulation to return to the Mastercam interface.

6 Save your part file. The same file will be used in a subsequent lesson.

You have now completed a basic multiaxis curve toolpath. Curve is generally used for 
trimming operations. The motion is typically straightforward, making it an ideal tool-
path for demonstrating some different tool axis control strategies and the effects they 
can produce on the tool. Proceed to Lesson 5 to explore these strategies.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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LESSON 5
5Tool Axis Control Options

Tool axis control is what separates multiaxis toolpaths from normal surface, chain, and 
point toolpaths. The ability to manipulate the angle of the tool, relative to the cut 
pattern, puts a great amount of control in your hands. The cut speed, finish quality, 
and tool life can all be affected with tool axis control. Complete this lesson to gain 
exposure with two additional tool axis control options for a multiaxis Curve toolpath.

Lesson Goals
 Open a previously saved part.
 Edit the operation’s parameters, specifically tool axis control.
 Generate the toolpath and observe the tool motion.

Exercise 1: Preparing the Part
1 Use File, Open to open the part file Curve_Toolpath_Lesson_5, which was 

provided with the tutorial.

2 Set your graphics view to Isometric.

3 Activate shading if necessary.

4 Fit the geometry to the screen using [Alt+F1] or the Fit button.

5 Choose File, Save As, and save the part under a different file name. This 
protects the original tutorial file from being overwritten.

Exercise 2: Copy and Edit an Operation
1 Right-click on the first operation and 

hold the mouse button down.

2 Drag the operation to a position 
farther down the Toolpaths 
Manager.

3 Release the right mouse button and 
select Copy after.
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4 Select operation 1 and turn off the 
toolpath display. Press [T] or click 
Toggle display on selected 
operations.

The visible toolpath belongs to 
operation 2.

5 Use the Levels Manager to make level 7:Chain visible.

The geometry on level 7 is used for tool axis control in this exercise.

6 In Toolpaths Manager, click 
Parameters under operation 2. The 
Multiaxis Toolpath - Curve dialog 
box opens.

7 Select Tool from the tree view pane.

8 Enter Chain in the Comment box.

A comment helps to distinguish 
operations of the same toolpath 
type.

9 Select Tool Axis Control from the tree view pane.

10 Choose Chain from the Tool axis control drop-down selection.

11 Click Select to open the Chaining dialog box.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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12 Select the chain as shown, and click OK in the Chaining dialog box

13 In the Chain Options dialog box, 
select Closest point on chain, and 
click OK to return to the Tool Axis 
Control page.

14 Click OK to accept the parameter changes.

15 Click Regenerate all dirty 
operations in the Toolpaths 
Manager.

16 Backplot the operation to observe the tool motion.

17 Save your part file.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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At this point in the lesson, take a moment to review the two operations created. Oper-
ation 1 uses To point for tool axis control. The tool is always pointing at the selected 
point. Operation 2 uses Chain for tool axis control. The tool is always pointing from a 
point on the chain, in this case, the closest point of the chain. The different options 
create drastically different tool and machine motion. The edge of the part will also 
have a different taper depending on the tool axis.

Toggle the toolpath display for the two operations so that they are both visible. Notice 
the different tool angle around the entire part shown below. Backplot the operations 
to see the different tool motion. Select both operations and run Machine Simulation as 
in the previous lesson. A collision is reported for operation 2 before you even run the 
simulation. This indicates that using the existing chain for tool axis control is not going 
to work on this particular machine. This does not indicate a bad toolpath; only the fact 
that this toolpath will not run on the selected machine.

Exercise 3: Copy and Edit a Second Operation
1 Right-click on the second operation and hold the mouse button down.

2 Drag the operation to a position farther down the Toolpaths Manager.

3 Release the right mouse button and select Copy after.

4 Select operation 2 and turn off the toolpath display, by pressing [T] or clicking 
the Toggle display on selected operations button.

The display for operations 1 and 2 are now both off.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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5 Use the Levels Manager to make level 8:Tool axis lines visible. Turn off the 
display of levels 1, 6, and 7.

6 In Toolpaths Manager, click 
Parameters under operation 3. The 
Multiaxis Toolpath - Curve dialog 
box opens.

7 Select Tool from the tree view pane.

8 Enter Lines in the Comment box.

9 Select Tool Axis Control from the tree view pane.

10 Choose Lines from the Tool axis control drop-down selection.

11 Click Select to open the Lines Tool Axis Control dialog box.

12 Click the Window select lines 
button to select lines for tool axis 
control.
INTRODUCTION TO MULTIAXIS TOOLPATHS
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13 Draw a selection window around the entire part. Only lines are selected.

14 Click OK in the Lines Tool Axis Control dialog box. You return to the Tool Axis 
Control page.

15 Click OK to accept the parameter changes.

16 Click the Regenerate all dirty 
operations button in the Toolpaths 
Manager.

17 Backplot the operation to observe 
the tool motion.

18 Save your part file.

Review the tool motion for operation 3. Observe how the tool axis lines up with each 
line as it approaches that point in the toolpath. The axis transitions from alignment 
with one line as it moves to the next. Use as many lines as necessary to achieve the 
desired motion.

Use Backplot and Machine Simulation to review the tool and machine motion for all 
three operations. The subtle differences in tool axis control put a great deal of power 
in your hands for generating complex toolpaths. Tool axis control is a key element to 
all multiaxis toolpaths, no matter which options are available on the page. Proceed to 
Lesson 6 where you will create two Multiaxis Drill operations using two of the tool axis 
control methods available for that toolpath type.
INTRODUCTION TO MULTIAXIS TOOLPATHS



LESSON 6
6Multiaxis Drill Toolpath

Multiaxis drill toolpaths differ from other multiaxis toolpaths in several ways:

 Limited cut pattern selection: points, points/lines, lines, or features
 Restricted tool axis control: parallel to line, surface, or plane
 Fewer tip control options: point, projected point, or compensation surface

The power of multiaxis drill becomes apparent on parts that contain multiple holes 
with center lines pointing in different directions. Your multiaxis machine is capable of 
drilling many different holes with a single fixture setup, saving time and increasing 
productivity.

Lesson Goals
 Open a part file and assign a machine definition.
 Create some Multiaxis Drill operations.
 Backplot the operations.

Exercise 1: Getting Started with Toolpath Creation
Assigning a machine definition is the first essential step in creating a toolpath. Setting 
the graphics view to allow the easiest geometry selection plays a small part in visual-
izing your work. This exercise guides you through the initial steps involved with 
creating a toolpath.

1 Open the part file Drill_Toolpath, which was provided with the tutorial.
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2 If not loaded, select the default Mill metric machine definition.

NOTE: The default machine definition has rotary axes defined that allow 
multiaxis toolpaths. Load the machine definition of your choice as long 
as it supports 5-axis motion.

3 Set your graphics view to Isometric.

4 Activate shading if necessary.

5 Fit the geometry to the screen using [Alt+F1] or the Fit button.

6 Choose File, Save As, and save the part under a different file name. This 
protects the original tutorial file from being overwritten.

Exercise 2: Create a Multiaxis Drill Toolpath
1 From the Toolpaths tab, choose 

Multiaxis, Drill.

2 Click OK if prompted to enter new 
NC file name.

3 Select Tool from the tree view pane.

4 Click the Select library tool button. 
The library defined in the machine 
definition opens.

5 Select the 10mm drill, and click OK.

Adjust the tool filter settings as 
necessary to make tool selection 
easier.
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6 Select Cut Pattern from the tree view pane.

7 Choose Points for the entity type.

8 Select Peck Drill for the cycle and set the subsequent parameters.

Cycle selection determines the available parameters. Choose different cycles 
to review the parameters.

9 Click Select points to return to the graphics window for point selection.

10 Select Window Points in the Drill 
Point Selection dialog box.
INTRODUCTION TO MULTIAXIS TOOLPATHS



42  MASTERCAM 2017 / Multiaxis Drill Toolpath
11 Create a window around the visible 
points.

The point geometry is on level 1.

12 Click OK in the Drill Point Selection dialog box to return to the Cut Pattern 
page.

13 Select Tool Axis Control from the tree view pane.

14 Choose Surface for Tool axis 
control and 5 axis for Output 
format.

15 Click Select to return to the graphics window for surface selection.

16 Select the surface as shown. Rotate the geometry as needed to allow 
selection.
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The surface is on level 5. Use the Levels Manager to make it visible if 
necessary.

TIP: Manipulating the visible levels makes the selection process easier 
and less susceptible to error.

17 Press [Enter] or click End Selection when done.

18 Select Collision Control from the tree view pane.

19 Set Tip control to Compensation 
surface.

Click Help for an explanation of the 
different tip control options.

20 Click the Select comp surfaces button next to Compensation surface. The 
Toolpath/surface selection dialog box opens.

21 Click Select to select surfaces in the 
graphics window.

22 Use the Levels Manager to make level 4 visible.
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23 Select the surface as shown. Rotate 
the geometry as needed to allow 
selection.

24 Press [Enter] or click End Selection when done.

25 Click OK in the Toolpath/surface selection dialog box.

26 Click OK to generate the multiaxis drill toolpath on the selected points.

27 Save your part file.

Exercise 3: Add a Second Multiaxis Drill Operation
1 In Levels Manager, turn off level 1, and make level 3 visible.

2 From the Toolpaths tab, choose Multiaxis, Drill.
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3 Select Tool from the tree view pane.

4 Select the 10mm drill shown in the 
tool list.

5 Select Cut Pattern from the Tree View pane.

6 Choose Points/Lines for the entity type.

7 The Cycle should still be Peck Drill. Set it if necessary.

8 Click Select points to return to the graphics window for point selection.

9 Select Window Points in the Drill 
Point Selection dialog box.

10 Draw a window around the visible 
points.

Change the view to Back and rotate 
the geometry as needed to bring the 
points/lines into view. The points for 
this operation are on the back side 
of the part.

NOTE: It is not necessary to select the lines, even though the entity type 
is set to Points/Lines. The lines are automatically selected as long as they 
end on the point.
INTRODUCTION TO MULTIAXIS TOOLPATHS



46  MASTERCAM 2017 / Multiaxis Drill Toolpath
11 Click OK in the Drill Point Selection dialog box to return to the Cut Pattern 
page.

12 Select Tool Axis Control from the tree view pane.

13 Check Output format to be sure it is set to 5 axis. Notice how Tool axis 
control is set to Points/Lines. The lines attached to the points are 
automatically set as the tool axis control.

14 Select Collision Control from the tree view pane.

15 Set Tip control to Original point.

16 Activate Tip compensation by 
selecting the checkbox. Set Break 
through to 2.0.

The break-through value determines 
how far the full diameter of the drill 
penetrates beyond the selected tip 
control geometry.
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17 Click OK to generate the multiaxis drill toolpath on the selected points.

18 Save your part file.

Exercise 4: Backplot the operations
1 Set your graphics view to Isometric.

2 In the Toolpaths Manager, click 
Select all operations.

3 Click Backplot selected operations 
in the Toolpaths Manager.
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4 In the Backplot dialog box, select the 
Display tool and Display rapid 
moves buttons.

5 Click Options in the Backplot dialog 
box.

6 Deselect the options shown and 
click OK. This prevents your part 
from spinning around and moving 
out of view.

7 Click Play to begin the backplot of your toolpath.

8 Click OK in the Backplot dialog box when you have finished reviewing the tool 
motion.

You have now completed a multiaxis drill toolpath. While this is the simplest of the 
multiaxis toolpaths, care must be taken when selecting geometry, tool axis control, 
and tip control methods. The differences between the control methods are subtle but 
can produce drastically different tool motion.
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Conclusion
Congratulations! You have completed the Introduction to Multiaxis Toolpaths tutorial. 
Now that you have mastered the skills in this tutorial, explore Mastercam’s other 
features and functions. 

You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
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Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 

To register, select Community, Link Account from the File tab, and follow 
the instructions.

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
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Attention! Updates may be available. 
Go to Mastercam.com/Support for the latest downloads.
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